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Content

►Creating Basic Documents
►Use HTML to structure a basic Web page by manipulating 

text and graphics
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text and graphics  
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Overview
► Hypertext Markup Language (HTML) is the foundation of all Web 

documents, or pages. 
► This module will teach you the basic elements and architecture of 

b d h HTML b i it t th
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a web page and how HTML brings it together. 
► You will learn to identify tags, view code, create hierarchies, 

format text and pages, and use styles and style sheets.
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Introduction
►It is important to know the elements involved with 

building Web pages. Upon completion of this lesson, you 
will be able to: 

H
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5 – Summarize Web page creation 

– List the elements of HTML 
– Identify HTML tags 
– View and evaluate HTML code in a page
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Basics

►The pages created with HTML are plain text. 
►You can create, edit, or view the HTML code for a Web 

page in any text editor such as Windows Notepad on any
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page in any text editor, such as Windows Notepad, on any 
computer platform.
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Web-Authoring Tools
►Although creating simple Web pages in a text editor is 

easy, it can become a tedious task. 
►Web-authoring tools, such as Microsoft FrontPage 
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Express and Macromedia Dreamweaver, allow you to 
create HTML Web pages in the same way word 
documents are created.
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Browsers
►When a Web page is open in a browser, the HTML code 

that creates the page is not visible. 
►Instead, the browser interprets the HTML code and 
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► s e d, e b owse e p e s e code d
displays the page appropriately on the screen.
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Edit Views
►If you are creating a Web page in a text editor and want to 

view the file, save your work and open the file in the 
browser. 

►You can then continue to edit save your work and view
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►You can then continue to edit, save your work, and view 
the results, switching between the text editor and the 
browser to see the effects of the edits.
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Browser Limitations
►The original intent of the HTML specification was to allow Web 

authors to describe the structure of a page without spending time on 
the look of a page. 
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►Traditionally, each browser had its own way of interpreting the look 
of the page, and the page created would appear differently on 
different browsers.
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Accurate Page Descriptions
►HTML can now describe the look of a page accurately. 
►More and more descriptive elements are being established 

in the HTML specification, such as font styles, sizes, 
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colors, and style sheets that can maintain a consistent look 
throughout a Web site.
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Text Limitations
►An author can specify a paragraph of text be defined as 

one of the six heading levels, but the HTML heading code 
cannot describe what a heading should look like. 

H
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5 ►The Web browser must differentiate each type of heading 

from the others.
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View Testing
►When a browser differentiates a non-specific message, one 

browser might display the first-level heading in a large font 
centered on the page, while another browser might display 

H
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5 it in italics and left-aligned on the page. 

►As a result, authors test pages in several of the more 
popular browsers.
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Standard Views
►The browser market has been consolidating and standardizing to 

eliminate interpretation problems. 
►There are few differences in the ways competing browsers display the 

widely accepted HTML features in a page
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widely accepted HTML features in a page. 
►However, new HTML features become available all the time, and 

Web authors must decide whether to include a new feature in a page 
when that feature may not be well interpreted by some browsers.
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Elements
►A Web page consists of elements, each of which is 

defined by an HTML code, or tag.
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Tag Architecture
►A tag is always enclosed in angle brackets, and most tags 

come in pairs, with an opening and a closing tag. 
►The closing tag is the same as the opening tag but starts
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►The closing tag is the same as the opening tag, but starts 
with a forward slash. 

►For example, to define text as a first-level heading in 
HTML, use the <H1> tag, as shown.
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Browsers

►A browser interprets tags and displays the text within the 
tags appropriately. 

►The tags themselves are not displayed within a browser
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►The tags themselves are not displayed within a browser 
unless there is a problem with a tag such as if one of the 
angle brackets was mistakenly left out.

►Most browsers will ignore any codes within angle 
brackets that they do not recognize.
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Attributes

►Some tags have optional or required attributes. An 
attribute is usually a keyword that takes one of several 
possible values.
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possible values. 
►A value is defined by enclosing it in quotes. 
►For example, the heading tag can take an optional 

alignment attribute.
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Uppercase or Lowercase

►You can create a tag in either uppercase or lowercase. 
►For example, the two tags <H1> and <h1> are equivalent 

to a browser
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to a browser.
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HTML tag

►The <HTML> tag declares that the text that follows 
defines an HTML Web page that can be viewed in a Web 
browser.
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browser. 
►The closing </HTML> tag ends the page.
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HEAD tag

►The <HEAD> tag defines the header area of a page, which 
is not displayed within the page itself in the browser. 

►The closing </HEAD> tag ends the header area
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►The closing </HEAD> tag ends the header area.
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TITLE tag

►Title TagThe text between <TITLE> and the closing 
</TITLE> tag is the title of the Web page and is displayed 
in the title bar of a browser.
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in the title bar of a browser. 
►The title should be descriptive; as it is frequently used by 

Web indexing and searching programs to name the Web 
page. 

►In Internet Explorer, a page title is the default name used 
when you save the page as a favorite location.

223BTE550 – Internet and Intranet Applications

when you save the page as a favorite location.

BODY tag

►The <BODY> tag delineates the actual content of the Web 
page that will be displayed in the browser. 

►There are several optional attributes for this tag
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►There are several optional attributes for this tag. 
►One of them is BACKGROUND, with which you can 

specify a background graphical image for the page.

224BTE550 – Internet and Intranet Applications
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Paragraph tag

►Use the paragraph tag (<P>) to mark the beginning of a 
new paragraph; the ending tag, </P>, is optional but 
should be included for clarity during revisions.
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should be included for clarity during revisions. 
►You can include the ALIGN attribute to specify whether 

the paragraph should be centered or right-aligned in the 
page.
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Comment tag
►The Comment tag is not revealed in the browser, but will be 

advantageous when editing or viewing the HTML code for a page. 
► In Internet Explorer, use the <!--> tag to create descriptive 
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comments within the code, which will be ignored by the browser. 
►With other browsers, you can use the combination of symbols to 

create a comment.
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Spaces

►You can include extra spaces and blank lines in HTML 
code to make the code easier to read and interpret. 

►When a browser opens a Web page it ignores multiple
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►When a browser opens a Web page, it ignores multiple 
spaces within the code and displays them as a single 
space.
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Hard Return

►HTML code ignores all hard returns within the code: for 
example, an Enter at the end of a text line you are editing 
in Notepad will not be displayed in the user's browser.
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in Notepad will not be displayed in the user s browser.
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Preformatted tag
►In the preformatted tag <PRE>, spaces and hard returns in 

the HTML code do display. 
►It instructs a browser to display the text in a mono-spaced
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►It instructs a browser to display the text in a mono spaced 
font that allows you to align text precisely, such as you 
would when showing a program listing.
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Information

►For additional documentation on tags used in HTML
http://werbach.com/barebones/barebones.html
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Underlying Code

►Most Web pages are built from the same text-based 
HTML language, so when viewing an interesting page in a 
browser, take a look at the underlying code.
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browser, take a look at the underlying code.
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Save as View

►To view a page's code, click View > Source in Internet 
Explorer or View > Page Source in Navigator to display 
the current page's HTML code within Notepad.
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the current page s HTML code within Notepad.
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Evolving Language

►HTML is constantly evolving. 
►Web authors may include new and improved tags within 

Web pages to produce new effects
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Web pages to produce new effects. 
►But browser software may not recognize those HTML 

features. 
►W3C at the MIT defines and establishes new versions of 

HTML to help with this problem. 
►U ffi i ll l d h Mi ft d N t
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►Unofficially, leaders such as Microsoft and Netscape, 
regularly invent their own extensions to official HTML 
which eventually may be included in the official HTML 
specification.

Structuring Web Pages

►When developing a Web page, you must determine a 
structure for your text and images using HTML that best 
suites your organization.
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suites your organization. 
►Upon completion of this lesson, you will be able to: 

– Add structure 
– Divide sections 
– Create hierarchies 

234BTE550 – Internet and Intranet Applications

– Format text and pages 
– Use styles and style sheets
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Adding Structure

►Adding structure will benefit any Web page you create. 
►To add basic structure to a page, add paragraphs and 

spaces to text
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spaces to text.
►To create a paragraph, enclose text within the paragraph 

tags (<P> and </P>). 
►Your browser will insert some extra space between 

paragraphs, so in some instances, you will not want to use 
the <P> tag
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the <P> tag.

Line Break tag

►You may not want extra space between each line of the 
address. 

►To avoid this use the line break tag <BR>
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►To avoid this, use the line-break tag, <BR>. 
►This break tells the browser to wrap the text that follows 

onto a new line without inserting any extra space between 
the lines.

236BTE550 – Internet and Intranet Applications
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Section Divisions

►A simple and effective way to separate sections within a 
Web page is to insert a horizontal line, which is also called 
a horizontal rule.
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a horizontal rule. 
►By default, the line stretches from one side of the page to 

the other.
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Structure Separations
► If your page has a banner across the top with a company name, you 

can insert a horizontal line beneath it. 
►This separates it from the table of contents showing links to pages, 

b th hi h i t th li f ll d b th i
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beneath which you can insert another line, followed by the main 
body of the page. 

►At the bottom of the page, you can have another line that shows 
important page identifiers.

238BTE550 – Internet and Intranet Applications
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HR tag
►The <HR> tag takes several optional attributes. For 

example, you can specify the line's thickness and how 
much of the browser's window it should span (as a 

t i i l )
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percentage or in pixels). 
►The line thickness default is one or two pixels in most 

browsers.
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Creating Headings

►A common way to add structure to a Web page is through 
the use of headings.

►A Web page can have a maximum of six levels of
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►A Web page can have a maximum of six levels of 
headings, the HTML codes for which are conveniently 
named <H1>, <H2>, <H3>, etc.

►No style is inherent in the headings — different Web 
browsers might interpret the look of a heading in slightly 
different ways.
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different ways. 
►Structurally, however, all browsers will display headings 

so low-level headings look subordinate to a higher-level 
heading.
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Heading Formats
► In a browser, a first-level heading is displayed in a larger, bolder 

font than a lower-level heading. 
►You can use HTML headings in any order, but it is recommended to 

use them in an outline format
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use them in an outline format. 
►The first-level heading, <H1>, is the highest level, and the sixth 

level, <H6>, is the lowest or most subordinate.
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Paragraphs

►Paragraphs are defined with the <p> tag.
<p>This is a paragraph</p>

< >Thi i th h</ >
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<p>This is another paragraph</p>

►HTML automatically adds an extra blank line before and 
after a paragraph.

242BTE550 – Internet and Intranet Applications
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Line Breaks

►The <br> tag is used when you want to end a line, but 
don't want to start a new paragraph. 

►The <br> tag forces a line break wherever you place it
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►The <br> tag forces a line break wherever you place it.
<p>This <br> is a para<br>graph with 
line breaks</p>

►The <br> tag is an empty tag. 
►It has no closing tag.
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Comments in HTML

►The comment tag is used to insert a comment in the 
HTML source code. A comment will be ignored by the 
browser. You can use comments to explain your code,
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browser. You can use comments to explain your code, 
which can help you when you edit the source code at a 
later date.
<!-- This is a comment -->

►Note that you need an exclamation point after the opening 
bracket, but not before the closing bracket.

244BTE550 – Internet and Intranet Applications

bracket, but not before the closing bracket.
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Text Formatting Tags 
TagTag DescriptionDescription
<b><b> Defines bold text

<big><big> Defines big text
<em><em> Defines emphasized text

fi i li
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<i><i> Defines italic text
<small><small> Defines small text
<strong><strong> Defines strong text

<sub><sub> Defines subscripted text
<sup><sup> Defines superscripted text
<ins><ins> Defines inserted text
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<del><del> Defines deleted text
<s><s> Deprecated. Use <del> instead

<strike><strike> Deprecated. Use <del> instead
<u><u> Deprecated. Use styles instead

"Computer Output" Tags

TagTag DescriptionDescription
<code> Defines computer code text
<kbd> Defines keyboard text
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<kbd> Defines keyboard text
<samp> Defines sample computer code

<tt> Defines teletype text
<var> Defines a variable
<pre> Defines preformatted text

<listing> Deprecated Use <pre> instead
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<listing> Deprecated. Use <pre> instead 
<plaintext> Deprecated. Use <pre> instead

<xmp> Deprecated. Use <pre> instead
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Citations, Quotations, and Definition Tags

TagTag DescriptionDescription
<abbr> Defines an abbreviation

H
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5 <acronym> Defines an acronym

<address> Defines an address element
<bdo> Defines the text direction

<blockquote> Defines a long quotation
<q> Defines a short quotation
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<q> Defines a short quotation
<cite> Defines a citation
<dfn> Defines a definition term

Character Entities
►Some characters have a special meaning in HTML, like the less than 

sign (<) that defines the start of an HTML tag. 
► If we want the browser to actually display these characters we must 

i h i i i h
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insert character entities in the HTML source.
►A character entity has three parts: an ampersand (&), an entity name 

or a # and an entity number, and finally a semicolon (;). 
►To display a less than sign in an HTML document we must write: 

&lt;&lt; or &#60;&#60;
►The advantage of using a name instead of a number is that a name is
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►The advantage of using a name instead of a number is that a name is 
easier to remember. 

►The disadvantage is that not all browsers support the newest entity 
names, while the support for entity numbers is very good in almost 
all browsers.
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Non-breaking Space

►The most common character entity in HTML is the non-
breaking space.

►Normally HTML will truncate spaces in your text
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►Normally HTML will truncate spaces in your text. 
►If you write 10 spaces in your text, HTML will remove 9 

of them. 
►To add spaces to your text, use the &nbsp;&nbsp; character 

entity.
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The Most Common Character Entities:

ResultResult DescriptionDescription Entity NameEntity Name Entity NumberEntity Number
non-breaking space &nbsp; &#160;
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< less than &lt; &#60;
> greater than &gt; &#62;
& ampersand &amp; &#38;
" quotation mark &quot; &#34;
' apostrophe &apos; &#39;

250BTE550 – Internet and Intranet Applications
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Some Other Commonly Used Character Entities

ResultResult DescriptionDescription Entity NameEntity Name Entity NumberEntity Number
¢¢ centcent &cent;&cent; &#162;&#162;
££ dd & d& d &#163&#163
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££ poundpound &pound;&pound; &#163;&#163;
¥¥ yenyen &yen;&yen; &#165;&#165;
§§ sectionsection &sect;&sect; &#167;&#167;
©© copyrightcopyright &copy;&copy; &#169;&#169;
®® registered trademarkregistered trademark &reg;&reg; &#174;&#174;

lti li tilti li ti &ti&ti &#215&#215
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×× multiplicationmultiplication &times;&times; &#215;&#215;
÷÷ divisiondivision &divide;&divide; &#247;&#247;

The Anchor Tag and the href Attribute
►HTML uses the <a> (anchor) tag to create a link to 

another document.
►An anchor can point to any resource on the Web: an
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►An anchor can point to any resource on the Web: an 
HTML page, an image, a sound file, a movie, etc.

►The syntax of creating an anchor: 
<a href="url">Text to be displayed</a> 

►The <a> tag is used to create an anchor to link from, the 
href attribute is used to address the document to link to
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href attribute is used to address the document to link to, 
and the words between the open and close of the anchor 
tag will be displayed as a hyperlink.
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The Target Attribute

►With the target attribute, you can define where the linked 
document will be opened.

►The line below will open the document in a new browser
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►The line below will open the document in a new browser 
window:

<a href="http://www.itu.edu.tr" target="_blank">
Visit ITU!

</a> 
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The Anchor Tag and the Name Attribute

►The name attribute is used to create a named anchor. 
When using named anchors we can create links that can 
jump directly into a specific section on a page, instead of
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jump directly into a specific section on a page, instead of 
letting the user scroll around to find what he/she is 
looking for.

►Below is the syntax of a named anchor:
<a name="label">Text to be displayed</a> 

►The name attribute is used to create a named anchor The
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►The name attribute is used to create a named anchor. The 
name of the anchor can be any text you care to use.

►The line below defines a named anchor:
►<a name="tips">Useful Tips Section</a> 
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The Anchor Tag and the Name Attribute

►You should notice that a named anchor is not displayed in 
a special way.

►To link directly to the "tips" section add a # sign and the
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►To link directly to the tips  section, add a # sign and the 
name of the anchor to the end of a URL, like this:
<a href="http://www.itu.edu.tr/index.html#kayit">
Kayıtla İlgili Bilgiler

</a>

►A hyperlink to the Useful Tips Section from WITHIN the 
fil “i d h " ill l k lik hi
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file “index.htm" will look like this: 
<a href="#tips">Jump to the Useful Tips Section</a> 

Frames

►With frames, you can display more than one HTML 
document in the same browser window. 

►Each HTML document is called a frame and each frame

H
TM

L
5

►Each HTML document is called a frame, and each frame 
is independent of the others.

►The disadvantages of using frames are:
– The web developer must keep track of more HTML 

documents 
It i diffi lt t i t th ti
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– It is difficult to print the entire page 
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The Frameset Tag

►The <framesetframeset> tag defines how to divide the window 
into frames 

►Each frameset defines a set of rows or columns

H
TM

L
5

►Each frameset defines a set of rows or columns 
►The values of the rows/columns indicate the amount of 

screen area each row/column will occupy 
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The Frameset Tag
►The <frame> tag defines what HTML document to put 

into each frame 
►In the example below we have a frameset with two 

columns
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columns. 
►The first column is set to 25% of the width of the browser 

window. The second column is set to 75% of the width of 
the browser window. The HTML document 
"frame_a.htm" is put into the first column, and the HTML 
document "frame_b.htm" is put into the second column:
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<frameset cols="25%,75%">
<frame src="frame_a.htm">
<frame src="frame_b.htm">

</frameset>
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Vertical frameset
<html><html>
<frameset cols="25%,50%,25%"><frameset cols="25%,50%,25%">
<frame src="frame_a.htm"><frame src="frame_a.htm">
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<frame src="frame_b.htm"><frame src="frame_b.htm">
<frame src="frame_c.htm"><frame src="frame_c.htm">

</frameset></frameset>
</html></html>
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Horizontal frameset
<html><html>
<frameset rows="25%,50%,25%"><frameset rows="25%,50%,25%">
<frame src="frame_a.htm"><frame src="frame_a.htm">
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<frame src="frame_b.htm"><frame src="frame_b.htm">
<frame src="frame_c.htm"><frame src="frame_c.htm">

</frameset></frameset>
</html></html>

260BTE550 – Internet and Intranet Applications
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Tables

►Tables are defined with the <tabletable> tag. 
►A table is divided into rows (with the <trtr> tag), and each 

row is divided into data cells (with the <tdtd> tag)
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row is divided into data cells (with the <tdtd> tag). 
►The letters tdtd stands for "table data," which is the content 

of a data cell. 
►A data cell can contain text, images, lists, paragraphs, 

forms, horizontal rules, tables, etc.
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Example

<table border="1">
<tr>
<td>ro 1 cell 1</td>
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<td>row 1, cell 1</td>
<td>row 1, cell 2</td>
</tr>
<tr>
<td>row 2, cell 1</td>
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<td>row 2, cell 2</td>
</tr>
</table>
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Tables and the Border Attribute

►If you do not specify a border attribute the table will be 
displayed without any borders. Sometimes this can be 
useful, but most of the time, you want the borders to 
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show. 
►To display a table with borders, you will have to use the 

border attribute:
<table border=“5">
<tr>
<td>Row 1, cell 1</td>
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<td>Row 1, cell 1</td>
<td>Row 1, cell 2</td>
</tr>
</table> 

Headings in a Table
►Headings in a table are defined with the <th> tag.

<table border="1">
<tr>
<th>Heading</th>
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<th>Heading</th>
<th>Another Heading</th>
</tr>
<tr>
<td>row 1, cell 1</td>
<td>row 1, cell 2</td>
</tr>
<t >
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<tr>
<td>row 2, cell 1</td>
<td>row 2, cell 2</td>
</tr>
</table> 
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Empty Cells in a Table

►Table cells with no content are not displayed very well in 
most browsers.
<table border="1">
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5 <tr>

<td>row 1, cell 1</td>
<td>row 1, cell 2</td>
</tr>
<tr>
<td>row 2, cell 1</td>
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<td>row 2, cell 1</td>
<td></td>
</tr>
</table> 

Table Tags
TagTag DescriptionDescription

<table> Defines a table
<th> Defines a table header

H
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5 <tr> Defines a table row

<td> Defines a table cell
<caption> Defines a table caption

<colgroup> Defines groups of table columns

<col> Defines the attribute values for one or more columns in a 
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<col> table
<thead> Defines a table head
<tbody> Defines a table body 
<tfoot> Defines a table footer 
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Unordered Lists
►An unordered list is a list of items. The list items are 

marked with bullets (typically small black circles).
►An unordered list starts with the <ul> tag. Each list item
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►An unordered list starts with the ul  tag. Each list item 
starts with the <li> tag.
<ul>
<li>Coffee</li>
<li>Milk</li>
</ l>
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</ul>

►Inside a list item you can put paragraphs, line breaks, 
images, links, other lists, etc.

Ordered Lists

►An ordered list is also a list of items. The list items are 
marked with numbers.

►An ordered list starts with the <ol> tag Each list item
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►An ordered list starts with the <ol> tag. Each list item 
starts with the <li> tag.
<ol>
<li>Coffee</li>
<li>Milk</li>
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</ol> 
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Definition Lists
►A definition list is not a list of items. This is a list of terms 

and explanation of the terms.
►A definition list starts with the <dl> tag. Each definition-
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►A definition list starts with the dl  tag. Each definition
list term starts with the <dt> tag. 

►Each definition-list definition starts with the <dd> tag.
<dl>
<dt>Coffee</dt>
<dd>Black hot drink</dd>

269BTE550 – Internet and Intranet Applications

/
<dt>Milk</dt>
<dd>White cold drink</dd>

</dl>

List Tags

TagTag DescriptionDescription
<ol> Defines an ordered list

H
TM

L
5 <ul> Defines an unordered list

<li> Defines a list item
<dl> Defines a definition list
<dt> Defines a definition term
<dd> Defines a definition description
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<dd> Defines a definition description
<dir> Deprecated. Use <ul> instead

<menu> Deprecated. Use <ul> instead
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►HTML Forms are used to select different kinds of user 
input.

HTML Forms and Input
H
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5

<formform name="input" action="html_form_action.asp" method="get">

Type your first name: 

<inputinput type="texttext" namename="FirstName" value="Binnur" sizesize="20">

<br>Type your last name: 
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<inputinput type="texttext" namename="LastName" value="Kurt" size="20">

<br>

<inputinput type="submitsubmit" valuevalue="SubmitSubmit">

</formform> 

►Web forms collect information from customers.  
►Web forms include different control elements including:

– Input boxes

Introducing Web Forms
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– Selection lists
– Drop-down list boxes
– Option buttons or radio buttons
– Check boxes
– Group boxes
– Text areas
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– Form buttons
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►While HTML supports the creation of forms, it does 
not include tools to process the information.

►Th i f ti b d th h

Forms and Server-Based Programs
H
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►The information can be processed through a 
program running on a Web server.
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►Server-based programs are written in many languages
►The earliest and most commonly used are Common 

Gateway Interface (CGI) scripts that are written in perl.

Forms and Server-Based Programs
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y ( ) p p
►Other popular languages include:

– AppleScript - PHP
– ASP - TCL
– ColdFusion - the Unix shell
– C/C++ - Visual Basic
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►Forms are created using the form element, structured as 
follows:

<form attributes>

Creating the Form Element
H

TM
L

5 elements
</form>

– where attributes are the attributes that control 
how the form is processed and elements are elements 
places within the form
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places within the form.

Creating the Form Element

►Form attributes usually tell the browser the location of the 
server-based program to be applied to the form’s data.

►Always specify an id or name for the form
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►Always specify an id or name for the form.
►Two attributes are available to identify the form: id and 

name.  
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►The syntax of the id and name attributes are as follows:

<form name=“name”  id=“id”>… </form>

Creating the Form Element
H
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/

Example:
<form name=“reg” id=“reg”> …    
</form>
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►The general syntax of input elements is as follows:
<input type=“type” name=“name” id=“id” />

Creating Input Boxes
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where type specifies the type of input field, and the 
name and id attributes provide the field’s name and id.

<input type=“text” name=“city” id=“city” />
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Type Description of what is displayed 

type=”button” button can be clicked to perform an action from a script  

type=”checkbox” check box

Form Input Types: <input type=
H
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5

type= checkbox  check box  

type=”file” browse button to locate and select a file  

type=”hidden” hidden field, not viewable on the form  

type=”image” Clickable inline image - performs an action from a 
script  

type=”password” text box in which hides text entered by the user  

type=”radio” radio (option) button  

279BTE550 – Internet and Intranet Applications

yp ( p )

type=”reset” button which resets the form when clicked  

type=”submit”  button which submits the form when clicked  

type=”text” text box in which displays text entered by the user  

 

►By default, an input box displays 20 characters of text.
►To change the width of an input box, use the size attribute 

which is displayed as follows:

Setting the Size of an Input Box
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which is displayed as follows:
<input size=“value” />

►<input type=“text” name=“zip” id=“zip 
size=“5” />
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Creating a Password Field

►A password field is an input box where characters typed 
by the user are displayed as bullets or asterisks to protect 
private or sensitive information on a Web site.
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p
►The syntax for creating a Password field is as follows:

<input type=“password” />
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Working with Form Labels

►link a label with an associated text element for scripting 
purposes.

►The syntax for creating a form label is as follows:
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►The syntax for creating a form label is as follows:
<label for=“zip”>Zip Code </label> 
Where id is the value of the id attribute for a field on the form, 

and 
label text is the text of the label.
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Creating a Selection List

►A selection list
– list box from which a user selects a particular value or set of 

values.  

H
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5 – Selection lists are useful when there are a fixed set of possible 

responses from the user.
►create selection list using <select> tag.
►specify each individual selection item using the <option> 

tag.
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Select list

<form id=“reg”>
<select name=“item” id=“item”>

< ti > d </ ti >
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<option> dogs </option>
<option> cats  </option>
<option> mice </option>

</select>
</form>
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Modifying the Appearance of a Selection List

►change the number of options displayed in the selection 
list 
– by modifying the size attribute

H
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– by modifying the size attribute.  
– Syntax:
<select size= “value”>… </select>

– Where value is the number of items that the selection list 
displays in the form.
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Modifying the Appearance of a Selection List

H
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L
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Making Multiple Selections

►Add the multiple attribute to the select element to create 
multiple selections

H
TM

L
5 <select multiple=“multiple”>… </select>
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Working with Option Groups
Use option groups to organize selection lists into distinct groups.

<select attributes>
<optgroup label=“label1”>
< ti >it 1</ ti >
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<option>itema1</option>
<option>itema2</option>

…
<select attributes>
<optgroup label=“label1”>
<option>itema1</option>
<option>itema2</option>
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<option>itema2</option>
…
</optgroup>
…
</select>
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Creating a Field Set
►HTML and XHTML allow you to organize option 

buttons into a group of fields called field sets.  
– Most browsers place a group box around a field set

H
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p g p
– indicates fields belong to a common group.

<fieldset>
fields

</fieldset>
– where fields are the individual fields within a set.
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Creating Check Boxes
►To create a check box, use:
<input type=“checkbox” name=“name” id=“id”
value=“value”/>

h th d id tt ib t id tif th h k b fi ld
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– where the name and id attributes identify the check box field 
and 

– the value attribute specifies the value sent to the server if the 
check box is selected.

►To specify that a check box be selected by default, use the checked 
attribute as follows:
<input type=“checkbox” checked=“checked” />
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<input type= checkbox  checked= checked />
or <input type=“checkbox” checked />
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Creating a Text Area Box

►Text area boxes allow users to enter comments about the 
products they’ve purchased.

►A i t b ld b t ll t d t th
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►An input box would be too small to accommodate the 
length of text for this use.
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Creating a Text Area Box
►To create a text area box, use the textarea element:

<textarea name=“name” id=“id” rows=“value”
cols=“value”>
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default text
</textarea>

Where the rows and cols attributes define 
– dimensions of the input box 
– rows attribute indicates the number of lines in the input box.
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►Buttons are a type of control element that performs an 
action.

►Types of buttons:

Working with Form Buttons
H
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►Types of buttons:
– Command button
– Submit button
– Reset button
– File button
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►Command buttons are created using the <input> tag:
<input type=“button” value=“text” />

►S b it b tt b it f t th f i

Creating a Command button
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►Submit buttons submit forms to the server for processing 
when clicked.  Syntax is as follows:
<input type=“submit” value=“text” />

►Reset buttons reset forms to their original (default) values.  
Syntax is as follows:
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<input type=“reset” value=“text” />
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Creating a File button
►File buttons are 

used to select files 
so that their 
contents can be 
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submitted for 
processing to a 
program.

►The Web page 
then only displays 
the file’s location, 
not the file’s
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not the file s 
contents.

Working with Hidden Fields

►Hidden fields are added to a form, but not displayed in 
the Web page.  

►The syntax is as follows:
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►The syntax is as follows:
<input type=“hidden” name=“name”
id=“id”  value=“value” />
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►After adding the elements to your form, you’ll need to specify 
where to send the form data and how to send it.  

►Use the following attributes:

Working with Form Attributes
H
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<form action=“url” method=“type”
enctype=“type”>

…
</form>

►where url specifies the filename and location of the program that 
processes
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processes 
– the form and the method attribute specifies how your Web 

browser sends data to the server.  
– The enctype attribute specifies the format of the data stored in 

the form’s field.

►The method attribute can have one of two values:
– Post

G t

Working with Form Attributes
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– Get
►The get method is the default

– get appends the form data to the end of the URL 
specified in the action attribute.

►The post method sends form data in a separate data stream
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– allows the Web server to receive the data through 
“standard input”.
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►The mailto action accesses the user’s own e-mail 
program and uses it to mail form information to a specified 
e-mail address.

Using the mailto Action
H
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5 ►By-passes the need for server-based programs.
►Syntax:
<form action-mailto:e-mail_address method=“post” 
enctype=“text/plain”> … </form>

where e mail address is the e mail address of the
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– where e-mail_address is the e-mail address of the 
recipient in the form.

►Newer browsers do not allow this action for security 
reasons

►Users typically navigate through a form with the tab key
►Specify an alternate tab order by adding the tabindex

attribute to any control element in your form

Specifying the Tab Order
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attribute to any control element in your form.
►Example:

<input name=“fname” tabindex=“1” />
►assigns the tab index number “1” to the fname 

field from the registration form.

300BTE550 – Internet and Intranet Applications



50

►An access key
– single key typed with the Alt key 
– in order to jump to one of the control elements in the

Specifying an Access Key
H
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– in order to jump to one of the control elements in the 
form.

►Create an access key by adding the accesskey attribute to 
any control element.

►Example of creating an access key for the lname field: 
<input name=“lname” accesskey=“1” />
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Form Tags

TagTag DescriptionDescription
<form> Defines a form for user input
<input> Defines an input field
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<input> Defines an input field
<textarea> Defines a text-area (a multi-line text input control)

<label> Defines a label to a control
<fieldset> Defines a fieldset
<legend> Defines a caption for a fieldset
<select> Defines a selectable list (a drop down box)
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<select> Defines a selectable list (a drop-down box)
<optgroup> Defines an option group

<option> Defines an option in the drop-down box
<button> Defines a push button
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The Image Tag and the ssrcrc Attribute

►In HTML, images are defined with the <img> tag.  
►The <img> tag is empty, which means that it contains 

attributes only and it has no closing tag
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attributes only and it has no closing tag 
►To display an image on a page, you need to use the src 

attribute
►►ssrcrc stands for "source" 
►The value of the srcsrc attribute is the URL of the image you 

t t di l
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want to display on your page
►The syntax of defining an image:

<img srcsrc="url"> 

The Alt Attribute

►The alt attribute is used to define an "alternate text" for an 
image. 

►The value of the alt attribute is an author defined text
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►The value of the alt attribute is an author-defined text 
<img src="boat.gif" alt="Big Boat"> 

►The "alt" attribute tells the reader what he or she is 
missing on a page if the browser can't load images. The 
browser will then display the alternate text instead of the 
image
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image. 
►It is a good practice to include the "alt" attribute for each 

image on a page, to improve the display and usefulness of 
your document for people who have text-only browsers. 
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Backgrounds

►The <body> tag has two attributes where you can specify 
backgrounds. The background can be a color or an image.

►The bgcolorbgcolor attribute specifies a background color for an
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►The bgcolorbgcolor attribute specifies a background-color for an 
HTML page. 

►The value of this attribute can be a hexadecimal number, 
an RGB value, or a color name
<body bgcolor="#000000">
<b d b l " b(0 0 0)">
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<body bgcolor="rgb(0,0,0)">
<body bgcolor="black"> 

►The lines above all set the background-color to black

Background

►The background attribute specifies a background-image 
for an HTML page. 

►The value of this attribute is the URL of the image you
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►The value of this attribute is the URL of the image you 
want to use. 

►If the image is smaller than the browser window, the 
image will repeat itself until it fills the entire browser 
window

<body background="clouds.gif">
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<body background clouds.gif >
<body 
background="http://www.cs.itu.edu.tr/bg.gif">
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Useful Tips

►The bgcolor, background, and the text attributes in the 
<body> tag are deprecated in the latest versions of HTML 
(HTML 4 and XHTML). 
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►The World Wide Web Consortium (W3C) has removed 

these attributes from its recommendations.
►Style sheets (CSS) should be used instead (to define the 

layout and display properties of HTML elements).
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Color Values
►Colors are defined using a hexadecimal notation for the 

combination of Red, Green, and Blue color values (RGB). 
►The lowest value that can be given to one light source is 0
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►The lowest value that can be given to one light source is 0 
(#00). The highest value is 255 (#FF).
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Color Names

►A collection of color names is supported by most 
browsers.

►Only 16 color names are supported by the W3C HTML
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►Only 16 color names are supported by the W3C HTML 
4.0 standard (aqua, black, blue, fuchsia, gray, green, lime, 
maroon, navy, olive, purple, red, silver, teal, white, and 
yellow). 

►For all other colors you should use the Color HEX value.
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16 Million Different Colors

►The combination of Red, Green and Blue values from 0 to 
255 gives a total of more than 16 million different colors 
to play with (256 x 256 x 256).
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to play with (256 x 256 x 256).
►Most modern monitors are capable of displaying at least 

16384 different colors.
►If you look at the color table (next slide), you will see the 

result of varying the red light from 0 to 255, while 
keeping the green and blue light at zero
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keeping the green and blue light at zero
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Red
rgb(0,0,0)
rgb(8,0,0)
rgb(16,0,0)
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rgb(255,0,0)


